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1. Introduction 
The PCA9745B evaluation board features LEDs for color mixing, blinking and dimming 
demonstrations. A graphical interface allows the user to easily explore the different 
functions of the driver. The board can be connected in series with other SPI-bus demo-
boards to create an evaluation system. 

The IC communicates to the host via the industry standard SPI-bus port. The evaluation 
software runs under Microsoft Windows PC platform. 

2. Features 
• A complete evaluation platform for the PCA9745B 16-channel SPI-bus constant 

current LED driver 
• Easy to use GUI based software demonstrates the capabilities of the PCA9745B 
• On-board four white and four RGB LEDs for visual experience 
• Convenient test points for easy scope measurements and signal access 
• USB interface to the host PC 
• No external power supply required 

3. Getting started 

3.1 Assumptions 
Familiarity with the SPI-bus is helpful but not required. 

3.2 Static handling requirements 

 

3.3 Minimum system requirements 
• PC Pentium 60 processor (or equivalent), 8 MB RAM, 10 MB of hard drive space 
• One USB port (either 2.0 or 1.1 compatible) 
• Windows 98SE, ME, 2000, XP, or Vista 
• Fm+ development board (OM13260) or WIN-I2CUSB board (from 

www.demoboard.com) 

3.4 Power requirements 
The NXP demonstration boards OM13260 and OM13524 hardware obtain power from 
the PC USB port. Care should be taken not to exceed the USB port current capabilities. 

CAUTION 

 

This device is sensitive to Electro Static Discharge (ESD). Therefore care 
should be taken during transport and handling. You must use a ground strap 
or touch the PC case or other grounded source before unpacking or 
handling the hardware. 
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4. Installation 

4.1 Fm+ development board and WIN-SPIUSB software 
The OM13524 is a daughter card to the OM13260 Fm+ I2C bus development board with 
SPI driver which is part of the Fm+ development board kit (OM13320). You may 
download the software, user manual, and find ordering information at the NXP web site: 
http://www.nxp.com/demoboard/OM13320.html#documentation 

The Win-SPIUSB software from The Boardshop runs on Windows 98SE, ME, 2000, and 
XP and is compatible with any PC hardware having a minimum of a Pentium processor 
and an USB port. The software allows the user to select one of the SPI-bus driver from a 
menu and also provides a Universal mode (SPI Expert mode) to allow users to create 
their own SPI-bus commands with the same SPI-bus devices. 

4.2 OM13524 connection to Fm+ I2C bus development board 
The OM13260 Fm+ I2C bus development board should be disconnected from your PC 
before connecting the OM13524 PCA9745B demo board on to it. The OM13524 board 
has a 9-pin male connector (CON1) that connects to the 8-pin male connector (CN16) on 
the Fm+ I2C bus development board using six jumper wires as shown in the Fig 1. 

CON1(9-pin)  CN16 (8-pin) 
3.3V (pin 4)    +3V3 (pin 2) 
SCL (pin 5)    MCU_SCLK (pin 4) 
GND (pin 6)    GND (pin 7) 
SDA (pin 7)    MCU_MOSI (pin 3) 
SPI_SDO (pin 8)    MCU_MISO (pin 1) 
SPI_CSN (pin 9)    MCU_SSN (pin 6) 

 

http://www.nxp.com/demoboard/OM13320.html%23documentation
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Fig 1. PCA9745B demo board (OM13524) connecting to the Fm+ development board (OM13260) 
 

4.3 OM13524 connection to WIN-I2CUSB hardware adapter board 
The Win-I2CUSB board should be disconnected from your PC before connecting the 
OM13524 PCA9745B demo board on to it. The OM13524 board has a 9-pin male 
connector (CON1) that connects to the 14-pin male connector (J1) on the Win-I2CUSB 
board using six jumper wires as shown in the Fig 2. 

CON1(9-pin)  J1 (14-pin) 

3.3V (pin 3)    3.3V (pin 2)a 

SCL (pin 5)    SCLK (pin 4) 

GND (pin 6)    GND (pin 6) 

SDA (pin 7)    MOSI (pin 8) 

SPI_SDO (pin 8)    MISO (pin 10) 

SPI_CSN (pin 9)    SSN (pin 12) 

Connect 6-jumper wires between the OM13524 board and the Win-I2CUSB board before 
connecting the USB cable. Once both boards are connected, connect the USB cable and 
start the Win-SPIUSB software. You are now ready to evaluate the PCA9745B. 
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Fig 2. PCA9745B demo board (OM13524) connecting to the WIN-I2CUSB board 
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Fig 3. PCA9745B demo board (OM13524) 
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5. Hardware description 
Fig 3 shows the following items on the hardware: 

• CON1 (9-pin male connector) is connected to SPI master device. 
• CON2 (9-pin female connector) is connected to next SPI daisy-chain device. 
• CON3 (5-pin male connector) is no use for PCA9745B SPI device. 
• CON4 (14-pin male connector) is connected to J1 on WIN-I2CUSB hardware board 

as I2C master device to drive this demo board (no connect for SPI signals) 
• J1 selects VDD power for PCA9745B, connected 1-2 for VDD = 5 V and connected 2-3 

for VDD = 3.3 V. 
• J13 selects LED power for all LEDs, connected 1-2 for VLED = 3.3 V and connected 2-

3 for VLED = 5 V. 
• J7 (7-8), J9 (9-10) and J10 (9-10) to select Vss for pin 2, SDO for pin 3 and /CS for 

pin 4 respectively. 
• LED[0:15] 16-channel output to drive four White LEDs (WHT_LED[1:4]) and four 

RGB LEDs (RGB_LED[1:4]). 
• TP2 and TP3 are GND pins for probing use. 
• TP1 can be connected as external reset signal to /RESET pin when J6 is open. 
• TP4 can be connected as external output enable signal to /OE pin for 

blinking/dimming control when J11 is open. 
• All jumpers default setting and function as shown in Table 1. 

 

Table 1. Jumper settings for test and evaluation 
Jumper Default setting Comment 
J1 
(3-pin) 

2-3 
(VDD = +3.3V) 

This jumper is used to select VDD for PCA9745B 
1-2: select +5V 
2-3: select +3.3V 

J2 
(3x2-pin) 

1-2 
(Rext=1 K, 
57 mA@max) 

This 3x2 jumper is used to select Rext (pin1) value for PCA9745B 
1-2: select Rext = 1K and max. o/p current is 57.3 mA 
3-4: select Rext = 1.5K and max. o/p current is 38.25 mA 
5-6: select Rext = 2K and max. o/p current is 28.6 mA 

J3 
(2-pin) 

Open Short: external 1.1K pull-up resistor for SDI on PCA9745B 
Open: no external pull-up resistor for SDI on PCA9745B 

J4 
(2-pin) 

Open Short: external 1.1K pull-up resistor for SCLK on PCA9745B 
Open: no external pull-up resistor for SCLK on PCA9745B 

J5 
(2-pin) 

Short Short: connect VDD_IN to VDD (pin28) on PCA9745B 
Open: connect current meter to measure the IDD on PCA9745B 

J6 
(2-pin) 

Open Short: force /RESET (pin25) to GND 
Open: 10K pull-up /RESET (pin25) to VDD 

J7 
(4x2-pin) 

7-8 This 4x2 jumper is used to select input value for pin 2 
Open: floating 
1-2: select VDD 

3-4: select pull-up with 31.6K 
5-6: select pull-down with 34.8K 
7-8: select GND 
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Jumper Default setting Comment 
J8 
(3-pin) 

2-3 This jumper is used to select bus mode 
1-2: select normal I2C or SPI addressable bus mode 
2-3: select SPI daisy-chain bus mode for PCA9745B 

J9 
(5x2-pin) 

9-10 
 

This 5x2 jumper is used to select input value for pin 3 
Open: floating 
1-2: select VDD 

3-4: select pull-up with 31.6K 
5-6: select pull-down with 34.8K 
7-8: select GND 
9-10: SDO for last slave device of PCA9745B in SPI daisy-chain 

J10 
(5x2-pin) 

9-10 This 5x2 jumper is used to select input value for pin 4 
Open: floating 
1-2: select VDD 

3-4: select pull-up with 31.6K 
5-6: select pull-down with 34.8K 
7-8: select GND 
9-10: CSN (Chip Select) SPI bus mode for PCA9745B 

J11 
(2-pin) 

Short Short: force /OE (pin5) to GND, to enable LEDs output 
Open: 10K pull-up /OE (pin5) to VDD when apply external clock for 
blinking/dimming on TP4 (test point) 

J12, J16 J19, 
J22 
(2-pin) 

Short These jumpers are used to open the WHT_LED1 or RGB_LED1 
J12 to control white LED, J16 to control Red LED, J19 to control Green 
LED, J22 to control Blue LED 
Open: connect current meter to measure one of the LEDs output current or 
open one of the LEDs output for detecting an LED open condition in one of 
EFLAGn register 
Short: normal operation for WHT_LED1 and RGB_LED1 

J13 
(3-pin) 

1-2 
(VLED = +3.3V) 

This jumper is used to select LED supply voltage 
1-2: select +3.3V for all LEDs supply voltage 
2-3: select +5V for all LEDs supply voltage 
Open (no jumper): select external voltage from J20 (≤ +20V) and J24 
(GND) 

J14, J18 (2-pin) Open These jumpers are used to merge the LED[0:2] outputs together for driving 
higher LED current. 
Open: normal operation for the LED[0:2] 
Short: When short J14/J18 and open J16/J19 to combine LED[0:2] outputs 
to drive LED0. When short J14 only and open J16 to combine LED[0:1] 
outputs to drive LED0 

J15, J17 J21, 
J23 
(2-pin) 

Open These jumpers are used to short the WHT_LED1 or RGB_LED1 
J15 to control white LED, J17 to control Red LED, J23 to control Green 
LED, J21 to control Blue LED 
Open: normal operation for WHT_LED1 and RGB_LED1 
Short: to short one of the LEDs for detecting an LED short condition in one 
of EFLAGn register 

J20 
(2-pin) 

+20V 
Input  

External ≤ +20V input for LEDs supply voltage 
The J13 must be OPEN to supply this ≤ +20V external voltage to all LEDs. 



 

 

NXP Semiconductors UM11009 
 PCA9745B demonstration board OM13524 

UM11009 All information provided in this document is subject to legal disclaimers. © NXP Semiconductors N.V. 2016. All rights reserved. 

User manual Rev. 1 — 23 June 2016 10 of 28 

Jumper Default setting Comment 
J24 
(2-pin) 

GND External GND input for LEDs supply voltage 

J25, J27 J29, 
J31 
(2-pin) 

Short These jumpers are used to open the WHT_LED4 or RGB_LED4 
J25 to control white LED, J27 to control Red LED, J29 to control Green 
LED, J31 to control Blue LED 
Open: connect current meter to measure one of the LEDs output current or 
open one of the LEDs output for detecting an LED open condition in one of 
EFLAGn register 
Short: normal operation for WHT_LED4 and RGB_LED4 

J26, J28 J30, 
J32 
(2-pin) 

Open These jumpers are used to short the WHT_LED4 or RGB_LED4 
J26 to control white LED, J28 to control Red LED, J32 to control Green 
LED, J30 to control Blue LED 
Open: normal operation for WHT_LED4 and RGB_LED4 
Short: to short one of the LEDs for detecting an LED short condition in one 
of EFLAGn register 

CON1 9-pin male connector This 9-pin male connector is connected to SPI master device or next daisy-
chain device 

CON2 9-pin female connector This 9-pin female connector is connected to next SPI daisy-chain device 

CON3 5-pin male connector No use for PCA9745B SPI device 

CON4 14-pin  
header 

This 14-pin header is used to connect to Win-I2CUSB hardware board as 
I2C master device to drive this demo board (no use for PCA9745B) 

TP1 Test Point 1 This TP1 is used to drive /RESET input pin25 from external when J6 is 
OPEN 

TP2, TP3 Test Point 2/3 These two test points are GND for probe ground connection 

TP4 Test Point 4 This TP4 is used to drive /OE input pin5 from external when J11 is OPEN 
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6. Schematic 
 

 

Fig 4. PCA9745B demo board schematic 
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7. OM13524 demonstration board main components 

Table 2. OM13524 demo board main components 

Device  Description LED Location 

PCA9745B 16-channel SPI-bus 57 mA / 20V 
constant current LED driver 

- U1 (See Fig 5) 

PRTR5V0U2AX ESD protection diode - U2 

LW-E67C White LED 4 white LEDs WHT_LED[1:4] 

LRTB_G6SG RGB LED 4 RGB LEDs RGB_LED[1:4] 

LTST-
C170GKT 

Green LED for PCA9745B power 
supply either 3.3 V or 5 V indicator 

1 green LED D1 

 

 

 

Fig 5. PCA9745B SPI Daisy-Chain LED driver block diagram 
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8. PCA9745B evaluation steps with WIN-I2CUSB board 
The PCA9745B is controlled by WIN-SPIUSB GUI in Expert mode as shown in Fig 6. 

 

 

Fig 6. Drop-down menu selection for SPI expert mode 

Connect the hardware as described in Section 4.3. All jumpers are in default setting for 
PCA9745B demo board. When you have correctly installed the software and the 
demonstration board hardware is connected and recognized by the computer, start the 
Win-SPIUSB software. As shown in the Fig 6, when the demonstration board hardware is 
correctly connected to the USB port and the computer recognizes it, the message 
“Hardware Detected” is displayed on the bottom of the window. 

Switched 3.3 V and 5.0 V output power supplies are controlled through the “Options” 
menu or by double clicking on the 3.3 V or 5.0 V symbols on the bottom of the window. 
Power supplies are disabled by default and you must enable them before using the SPI-
bus device on the board. SPI Frequency and Mode are controlled through the “Options” 
menu or by double clicking on the frequency or mode symbol on the bottom of the 
window. 

8.1 PCA9745B blinking demo for all White and RGB LEDs 
1. From the ‘Device’ drop-down menus select ‘Universal Modes’, and from the 

subsequent drop-down menu select ‘Expert Mode’ as shown in Fig 6. 
2. Copy the “PCA9745B WHT_RGB LEDs blinking demo” text file as shown below. 

From the ‘File’ drop-down menus select ‘Open’, and from the “open data file” window 
to select this text file. 
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SPI Data File 2 

0,04,55,Comments: set LEDOUT0 = 55h, turn on LEDs 

,02,00 

0,06,55,Comments: set LEDOUT1 = 55h, turn on LEDs 

,04,55 

0,08,55,Comments: set LEDOUT2 = 55h, turn on LEDs 

,06,55 

0,0A,55,Comments: set LEDOUT3 = 55h, turn on LEDs 

,08,55 

2000,82,80,Comments: write IREFALL = 80h 

0,0A,55  

0,82,00,Comments: write IREFALL = 00h 

0,02,80 

1500,82,40,Comments: write IREFALL = 80h 

0,02,00 

0,82,00,Comments: write IREFALL = 00h 

0,02,40 

1000,82,20,Comments: write IREFALL = 80h 

0,02,00 

0,82,00,Comments: write IREFALL = 00h 

0,02,20 

500,82,10,Comments: write IREFALL = 80h 

0,02,00 

0,02,21,Comments: set group control = blinking 

0,02,10 

0,04,FF,Comments: set LEDOUT0 = FFh 

0,02,21 

0,06,FF,Comments: set LEDOUT1 = FFh 

,04,FF 

0,08,FF,Comments: set LEDOUT2 = FFh 

,06,FF 

0,0A,FF,Comments: set LEDOUT3 = FFh 

,08,FF 

0,80,C0,Comments: set PWMALL=C0h 

0,0A,FF 

0,0C,40,Comments: set GRPPWM=40 

0,00,C0 
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2000,0E,00,Comments: set GRPFREQ=00 

0,0C,40 

0,0C,80,Comments: set GRPPWM=80 

0,0E,00 

2000,0E,01,Comments: set GRPFREQ=01 

0,0C,80 

0,0C,A0,Comments: set GRPPWM=A0 

0,0E,01 

2000,0E,02,Comments: set GRPFREQ=02 

0,0C,A0 

0,0C,C0,Comments: set GRPPWM=C0 

0,0E,02 

2000,0E,03,Comments: set GRPFREQ=03 

0,0C,C0 

0,82,00,Comments: write IREFALL = 00h 

0,0E,03 

Sequence:01,02,03,04,05,06,07,08,09,10,11,12,13,14,15,16,17,18,19,20,21,22,23,24,25,26 

 

3. After open the “PCA9745B WHT_RGB LEDs blinking demo” text file, the WIN-
I2CUSB GUI in Expert mode screen will be displayed as shown in Fig 7. 

4. Click the ‘Send All’ button, all the valid messages on the screen will be sent in the 
order of the row number (Msg #). The action will be performed one time. 

5. User can program the MOSI (Master Out Slave In) Data to PCA9745B, the first 7-bit 
is to access the address of register and 8th bit to indicate Read (1) or Write (0), the 
next byte is data to read or write. 
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Fig 7. Message data in Expert mode to demo all White and RGB LEDs for blinking 
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9. PCA9745B evaluation steps with Fm+ development board 
The PCA9745B is controlled by Fm+ development board GUI in Expert mode as shown 
in Fig 8. 

 

 

Fig 8. Selecting Expert Mode from Fm+ development board GUI 

Connect the hardware as described in Section 4.2. All jumpers are in default setting for 
PCA9745B demo board. When you have correctly installed the software and the 
demonstration board hardware is connected and recognized by the computer, start the 
Fm+ development board software. As shown in Fig 8, when the demonstration board 
hardware is correctly connected to the USB port and the computer recognizes it, the 
message “USB-I2C Hardware Detected” is displayed on the bottom of the window. SPI 
Frequency is controlled through the “Options” menu or by clicking on the frequency 
symbol on the bottom of the window. 

9.1 PCA9745B gradation demo for White and Red LEDs 
1. From the ‘Device’ drop-down menus select ‘Expert Modes’ as shown in Fig 8. 
2. Copy the “PCA9745B gradation demo in continuous mode“ text file as shown below. 

From the ‘File’ drop-down menus select ‘Open’, and from the “open data file” window 
to select this text file. 
 
SPI Data File 2 

0,04,05,Comments: LEDOUT0 turn on WHT_RED LEDs 

,02,00 
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0,06,05,Comments: LEDOUT1 

,04,05 

0,08,05,Comments: LEDOUT2 

,06,05 

0,0A,05,Comments: LEDOUT3 

,08,05 

0,02,05,Comments: set Exponential adjust for gradation 

,0A,05 

0,50,C3,Comments: set RAMP_RATE_GRP0 

,02,05 

0,52,47,Comments: set STEP_TIME_GRP0 

,50,C3 

0,54,D2,Comments: set HOLD_CNTL_GRP0 

,52,47 

0,56,80,Comments: set IREF_GRP0 

,54,D2 

0,58,C3,Comments: set RAMP_RATE_GRP1 

,56,80 

0,5A,47,Comments: set STEP_TIME_GRP1 

,58,C3 

0,5C,D2,Comments: set HOLD_CNTL_GRP1 

,5A,47 

0,5E,80,Comments: set IREF_GRP1 

,5C,D2 

0,70,33,Comments: set GRAD_MODE_SEL0 

,5E,80 

0,72,33,Comments: set GRAD_MODE_SEL1 

,70,33 

0,74,E4,Comments: set GRAD_GRP_SEL0 

,72,33 

0,76,E4,Comments: set GRAD_GRP_SEL1 

,74,E4 

0,78,E4,Comments: set GRAD_GRP_SEL2 

,76,E4 

0,7A,E4,Comments: set GRAD_GRP_SEL3 

,78,E4 

0,82,01,Comments: must set IREFALL = 01 during gradation 

,7A,E4 

2000,7C,0F,Comments: set GRAD_CNTL 
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,02,01 

Sequence:01,02,03,04,05,06,07,08,09,10,11,12,13,14,15,16,17,18,19,20,21 

 

3. After open the “PCA9745B gradation demo in continuous mode” text file, the “NXP 
Fm+ Board GUI” in Expert mode screen will be displayed as shown in Fig 9. 

4. Click the ‘Send All’ button, all the valid messages on the screen will be sent in the 
order of the row number (Msg #). The action will be performed one time. 

5. User can program the MOSI (Master Out Slave In) Data to PCA9745B, the first 7-bit 
is to access the address of register and 8th bit to indicate Read (1) or Write (0), the 
next byte is data to read or write. 

 

 

Fig 9. Message data in Expert mode to demo all white and red LEDs for gradation 

9.2 Two PCA9745B demo boards in daisy-chain connection 
1. From the ‘Device’ drop-down menus select ‘Expert Modes’ as shown in Fig 8. 
2. Copy the “SPI daisy chain demo with two PCA9745B devices“ text file as shown 

below. From the ‘File’ drop-down menus select ‘Open’, and from the “open data file” 
window to select this text file. 

 
SPI Data File 2 

0,80,80,80,80,Comments: set PWMALL=80h 

,00,80,00,80 

900,82,20,82,10,Comments: set IREFALL=20h, 10h 

,02,20,02,10 
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900,82,00,82,00,Comments: set IREFALL=00 

,02,00,02,00 

0,04,55,04,01,Comments: set LEDOUT0 (02h->04h due to bit0=0 is write bit) = 55h 1st device; 01h for 
2nd device white LEDs ON;  

0,02,00,02,00 

0,06,55,06,01,Comments: set 2nd device 55h & 1st device 01h for LEDOUT1 

0,06,55,06,01 

0,08,55,08,01,Comments: set LEDOUT2 = 55h & 01h 

0,08,55,08,01 

0,0A,55,0A,01,Comments: set LEDOUT3 = 55h & 01h 

0,08,55,08,01 

800,82,10,82,40,Comments: write IREFALL = 10h & 40h 

0,0A,55,0A,01 

800,04,01,04,40,Comments: set LEDs on 

0,04,01,04,40 

800,06,01,06,40,Comments: set LEDs ON 

0,04,01,04,40 

800,08,01,08,40,Comments: set LEDs on 

0,0A,01,0A,40 

800,0A,01,0A,40,Comments: set LEDs on 

0,04,04,04,10 

600,04,04,04,10,Comments: set LEDs on 

,06,04,06,10 

600,06,04,06,10,Comments: set LEDs on 

,08,04,08,10 

600,08,04,08,10,Comments: set LEDs on 

0,04,10,04,04 

600,0A,04,0A,10,Comments: set LEDs on 

0,08,04,08,10 

500,04,10,04,04,Comments: set LEDs on 

0,04,04,04,10 

500,06,10,06,04,Comments: set LEDs ON 

0,04,10,04,04 

500,08,10,08,04,Comments: set LEDs on 

0,06,10,06,04 

500,0A,10,0A,04,Comments: set LEDs on 

0,08,10,08,04 

800,82,00,82,00,Comments: write IREFALL = 00 

0,0A,10,0A,04 
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800,02,05,82,80,Comments: write IREFALL = 80h & set exp. gradation adjust for 2nd device  

0,02,00,02,00 

0,04,01,82,00,Comments: write IREFALL = 00h, set LDR=01 for 2nd device 

0,02,05,02,80 

0,06,01,04,40,Comments: set LEDOUT0 = 40h for blue LEDs ON, set LDR=01 for 2nd device 

0,04,01,02,00 

0,08,01,06,40,Comments: set LEDOUT1 = 40h, set LDR=01 for 2nd device 

0,06,01,04,40 

0,0A,01,08,40,Comments: set LEDOUT2 = 40h, set LDR=01 for 2nd device 

0,08,01,06,40 

0,50,C3,0A,40,Comments: set LEDOUT3 = 40h, set RAMP_RATE_GRP0=c3h 

0,0A,01,08,40 

800,52,47,82,80,Comments: write IREFALL = 80h, set STEP_TIME_GRP0=47h 

0,50,C3,0A,40 

0,54,D0,82,00,Comments: write IREFALL = 00h, set HOLD_CNTL_GRP0=D0h 

0,52,47,02,80 

0,56,F0,04,05,Comments: set LEDOUT0 = 05h turn on W_R_G_B LEDs, set IREF_GRP0=F0h 

0,54,D0,02,00 

0,70,11,06,10,Comments: set LEDOUT1 = 10h, set GRAD_MODE_SEL0=11h 

0,56,F0,04,05 

0,72,11,08,40,Comments: set LEDOUT2 = 40h, set GRAD_MODE_SEL1=11h 

0,70,11,06,10 

0,74,E4,0A,00,Comments: set LEDOUT3 = 00h, set GRAD_GRP_SEL0=E4h 

0,72,11,08,40 

800,76,E4,82,20,Comments: write IREFALL = 20h, set GRAD_GRP_SEL1=E4h 

0,74,E4,0A,00 

0,78,E4,82,00,Comments: write IREFALL = 00h, set GRAD_GRP_SEL2=E4h 

0,76,E4,02,20 

0,7A,E4,04,00,Comments: set LEDOUT0 = 00h, set GRAD_GRP_SEL3=E4h 

0,78,E4,02,00 

1,7C,03,06,05,Comments: set LEDOUT1 = 05h, set GRAD_CNTL=03h 

0,7A,E4,04,00 

4000,82,01,08,10,Comments: set LEDOUT2 = 10h, set IREFALL not 0 to enable gradation operation 

0,7C,03,06,05 

0,74,00,0A,40,Comments: set LEDOUT3 = 40h, set GRAD_GRP_SEL0=00h 

0,02,01,08,10 

800,76,00,82,1F,Comments: write IREFALL = 1Fh, set GRAD_GRP_SEL1=00h 

0,74,00,0A,40 

0,78,00,82,00,Comments: write IREFALL = 00h,set GRAD_GRP_SEL2=00h 



 

 

NXP Semiconductors UM11009 
 PCA9745B demonstration board OM13524 

UM11009 All information provided in this document is subject to legal disclaimers. © NXP Semiconductors N.V. 2016. All rights reserved. 

User manual Rev. 1 — 23 June 2016 22 of 28 

0,76,00,02,1F 

0,7A,00,04,40,Comments: set LEDOUT0 = 40h,set GRAD_GRP_SEL2=00h 

0,78,00,02,00 

0,04,05,06,00,Comments: set LEDOUT1 = 00h, LEDOUT0=05h 

0,7A,00,04,40 

0,06,05,08,05,Comments: set LEDOUT2 = 05h, LEDOUT1=05h 

0,04,05,06,00 

0,08,05,0A,10,Comments: set LEDOUT3 = 10h,LEDOUT2=05h 

0,06,05,08,05 

4000,0A,05,82,0F,Comments: write IREFALL = 0Fh,LEDOUT3=05h 

0,08,05,0A,10 

0,70,FF,82,00,Comments: write IREFALL = 00h,set GRAD_MODE_SEL0=FFh 

0,0A,05,02,0F 

0,72,FF,04,10,Comments: set LEDOUT0 = 10h,set GRAD_MODE_SEL1=FFh 

0,70,FF,02,00 

0,04,50,06,40,Comments: set LEDOUT1 = 40h,LEDOUT0=50h 

0,72,FF,04,10 

0,06,50,08,00,Comments: set LEDOUT2 = 00h,LEDOUT1=50h 

0,04,50,06,40 

0,08,50,0A,05,Comments: set LEDOUT3 = 05h,LEDOUT2=50h 

0,06,50,08,00 

4000,0A,50,82,07,Comments: write IREFALL = 07h,LEDOUT3=50h 

0,08,50,0A,05 

0,04,55,02,21,Comments: set group control = blinking,LEDOUT0=55h 

0,0A,50,02,07 

0,06,55,04,FF,Comments: set LEDOUT0 = FFh,LEDOUT1=55h 

0,04,55,02,21 

0,08,55,06,FF,Comments: set LEDOUT1 = FFh,LEDOUT2=55h 

0,06,55,04,FF 

0,0A,55,08,FF,Comments: set LEDOUT2 = FFh,LEDOUT3=55h 

0,08,55,06,FF 

0,05,FF,0A,FF,Comments: set LEDOUT3 = FFh, read LEDOUT0 register from 2nd device 

0,0A,55,08,FF 

400,07,FF,80,C0,Comments: set PWMALL=C0h, read LEDOUT1 from 2nd device 

0,00,55,0A,FF 

500,09,FF,0C,40,Comments: set GRPPWM=40, read LEDOUT2 from 2nd device  

0,00,55,00,C0 

5000,0B,FF,0E,00,Comments: set GRPFREQ=00, read LEDOUT3 from 2nd device 

0,00,55,0C,40 
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800,FF,FF,0C,80,Comments: set GRPPWM=80, NOP for 2nd device 

0,00,55,0E,00 

5000,FF,FF,0E,01,Comments: set GRPFREQ=01, NOP for 2nd device 

0,00,00,0C,80 

1,82,00,82,00,Comments: set IREFALL=00 

0,00,00,0E,01 

Sequence:01,02,03,04,05,06,07,08,09,10,11,12,13,14,15,16,17,18,19,20,21,22,23,24,25,26,27,28,29,30,3
1,32,33,34,35,36,37,38 

 

3. The Fm+ development board as SPI master drives two PCA9745B demo boards in 
daisy-chain as shown in the Fig 10. After open the “SPI daisy chain demo with two 
PCA9745B devices” text file, the “NXP Fm+ Board GUI” in Expert mode screen will 
be displayed all messages, then click the ‘Send All’ button, all the valid messages on 
the screen will be sent in the order of the row number (Msg #). The action will be 
performed one time. 

 

 

Fig 10. Two PCA9745B demo boards connecting to the Fm+ development board 
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10. Support 
For support, please send an email to: i2c.support@nxp.com 

 

11. Abbreviations 
   

Table 2. Abbreviations  

Acronym Description 

ESD Electro Static Discharge 

GUI Graphical User Interface 

I2C-bus Inter-integrated Circuit bus 

IC Integrated Circuit 

LED Light Emitting Diode 

MISO Master In, Slave Out 

MOSI Master Out, Slave In 

PC Personal Computer 

PWM Pulse Width Modulator 

RAM Random Access Memory 

RGB Red/Green/Blue 

RGBA Red/Green/Blue/Amber 

SPI Serial Peripheral Interface 

USB Universal Serial Bus 

 

12. References 
[1] PCA9745B, 16-channel Fm+ I2C-bus 57 mA / 20V constant current LED driver 

Product data sheet; NXP Semiconductors: 
http://www.nxp.com/documents/data_sheet/PCA9745B.pdf 
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13. Legal information

13.1 Definitions 
Draft — The document is a draft version only. The content is still under 
internal review and subject to formal approval, which may result in 
modifications or additions. NXP Semiconductors does not give any 
representations or warranties as to the accuracy or completeness of 
information included herein and shall have no liability for the consequences 
of use of such information. 

13.2 Disclaimers 
Limited warranty and liability — Information in this document is believed to 
be accurate and reliable. However, NXP Semiconductors does not give any 
representations or warranties, expressed or implied, as to the accuracy or 
completeness of such information and shall have no liability for the 
consequences of use of such information. NXP Semiconductors takes no 
responsibility for the content in this document if provided by an information 
source outside of NXP Semiconductors. 

In no event shall NXP Semiconductors be liable for any indirect, incidental, 
punitive, special or consequential damages (including - without limitation - 
lost profits, lost savings, business interruption, costs related to the removal or 
replacement of any products or rework charges) whether or not such  
damages are based on tort (including negligence), warranty, breach of 
contract or any other legal theory. 

Notwithstanding any damages that customer might incur for any reason 
whatsoever, NXP Semiconductors’ aggregate and cumulative liability 
towards customer for the products described herein shall be limited in 
accordance with the Terms and conditions of commercial sale of NXP 
Semiconductors. 

Right to make changes — NXP Semiconductors reserves the right to make 
changes to information published in this document, including without 
limitation specifications and product descriptions, at any time and without 
notice. This document supersedes and replaces all information supplied prior 
to the publication hereof. 

Suitability for use — NXP Semiconductors products are not designed, 
authorized or warranted to be suitable for use in life support, life-critical or 
safety-critical systems or equipment, nor in applications where failure or 
malfunction of an NXP Semiconductors product can reasonably be expected 
to result in personal injury, death or severe property or environmental 
damage. NXP Semiconductors and its suppliers accept no liability for 
inclusion and/or use of NXP Semiconductors products in such equipment or 
applications and therefore such inclusion and/or use is at the customer’s 
own risk.  

Applications — Applications that are described herein for any of these 
products are for illustrative purposes only. NXP Semiconductors makes no 
representation or warranty that such applications will be suitable for the 
specified use without further testing or modification.  

Customers are responsible for the design and operation of their applications 
and products using NXP Semiconductors products, and NXP 
Semiconductors accepts no liability for any assistance with applications or 

customer product design. It is customer’s sole responsibility to determine 
whether the NXP Semiconductors product is suitable and fit for the 
customer’s applications and products planned, as well as for the planned 
application and use of customer’s third party customer(s). Customers should 
provide appropriate design and operating safeguards to minimize the risks 
associated with their applications and products.  

NXP Semiconductors does not accept any liability related to any default, 
damage, costs or problem which is based on any weakness or default in the 
customer’s applications or products, or the application or use by customer’s 
third party customer(s). Customer is responsible for doing all necessary 
testing for the customer’s applications and products using NXP 
Semiconductors products in order to avoid a default of the applications and 
the products or of the application or use by customer’s third party 
customer(s). NXP does not accept any liability in this respect. 

Export control — This document as well as the item(s) described herein 
may be subject to export control regulations. Export might require a prior 
authorization from competent authorities. 

Translations — A non-English (translated) version of a document is for 
reference only. The English version shall prevail in case of any discrepancy 
between the translated and English versions. 

Evaluation products — This product is provided on an “as is” and “with all 
faults” basis for evaluation purposes only. NXP Semiconductors, its affiliates 
and their suppliers expressly disclaim all warranties, whether express, 
implied or statutory, including but not limited to the implied warranties of non-
infringement, merchantability and fitness for a particular purpose. The entire 
risk as to the quality, or arising out of the use or performance, of this product 
remains with customer. 

In no event shall NXP Semiconductors, its affiliates or their suppliers be 
liable to customer for any special, indirect, consequential, punitive or 
incidental damages (including without limitation damages for loss of 
business, business interruption, loss of use, loss of data or information, and 
the like) arising out the use of or inability to use the product, whether or not 
based on tort (including negligence), strict liability, breach of contract, breach 
of warranty or any other theory, even if advised of the possibility of such 
damages.  

Notwithstanding any damages that customer might incur for any reason 
whatsoever (including without limitation, all damages referenced above and 
all direct or general damages), the entire liability of NXP Semiconductors, its 
affiliates and their suppliers and customer’s exclusive remedy for all of the 
foregoing shall be limited to actual damages incurred by customer based on 
reasonable reliance up to the greater of the amount actually paid by 
customer for the product or five dollars (US$5.00). The foregoing limitations, 
exclusions and disclaimers shall apply to the maximum extent permitted by 
applicable law, even if any remedy fails of its essential purpose. 

13.3 Trademarks 
Notice: All referenced brands, product names, service names and 
trademarks are property of their respective owners. 
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